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The 2026  Social Media
Guide for Charities 



Introduction

This guide, produced by Third Sector Lab, builds on OSCR’s
2015 Ready, Set, Go guide and reimagines it for 2026 - a year
where social media will keep evolving, but the fundamentals of
trust, clarity, and human connection matter more than ever.

Social media is no longer a side-channel or noticeboard. For
many people, it’s the front door to your charity - the first place
they’ll learn about your cause. Yet in too many organisations,
it’s still underfunded, treated as an afterthought, or handed to
one overstretched staff member. That mismatch shows.

Audiences’ expectations have shifted. They’re tired of spin and
crave transparency. They want real voices - staff,
volunteers, and people with lived experience - not polished
slogans. They want hope as well as urgency, especially in
sectors where heavy messaging has dominated. Young people
care about causes, but they’ll scroll past content that feels
tokenistic or out of touch. And if all you do is broadcast
announcements, you’ll miss the real power of social: building
community, conversation, and action.

Charities and community organisation
teams are stretched. Social media is
rarely anyone’s only job - most of us are
also running services, raising funds,
recruiting volunteers, and reporting to
trustees. This guide is written for that
reality.
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Researched and written by Third Sector Lab for OSCR, this guide is
aimed at staff, volunteers and trustees of charities who want to use
social media with confidence — focusing on real-world outcomes, safe
practice, and approaches that small teams can actually keep up.



Ready     Set     Go     Measure

Less is more. Focus beats volume.

Go where your audiences are. Meet people in their
spaces, not yours.

Digital is everyone’s responsibility. Frontline teams
hold the stories and the questions people really ask.

Authentic voices cut through corporate comms.
When people share their experiences with consent and
dignity, it changes minds and inspires action.

Align audience → channel → content. If those three
don’t line up, don’t post.
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This guide will help you avoid common traps - like chasing awareness
without impact, or letting long approval chains kill good ideas. It will
also point you toward overlooked opportunities: LinkedIn and YouTube
Shorts for partnership and reach, employee-generated content as the
future of influence, and storytelling that sparks solidarity rather than
despair.

At the heart of it are five principles that separate noise from impact:

This is a practical handbook for 2026. It blends narrative, checklists,
and case studies so you can use it however you need: end-to-end, or
dipped into section by section.
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Section 1. 
Ready! 
(Plan with Purpose)
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Ready!
Before a single post goes live, decide what
you want to change in the world and who
needs to hear from you for that to happen.
That doesn’t mean a glossy 40-page strategy.
A page or two of sharp, shared focus will do -
so long as it’s clear enough for everyone on
your team to use.
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Checklist - Outcome sanity check

Is it specific and time-bound?
Is there just one action tied to it?
Is the journey from post → page → action simple on a
phone?
Is there one number you’ll use to judge success?

Awareness isn’t the goal - action is. A post with 1,000 likes but no
sign-ups, donations, or conversations isn’t success. Pick one to three
outcomes for the next 8–12 weeks and make them measurable:

“Fill 25 counselling slots by 30 Nov.”
“Recruit 40 event volunteers by 15 Dec.”
“Raise £12,000 for our winter appeal.”
“Secure 300 supporter emails to MSPs.”
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The wording matters less than the clarity. For each outcome, sketch
the path you’ll offer: a post with a clear promise → a single mobile-
friendly landing page → one action (sign up, donate, apply) → a
thank-you that closes the loop. If the path is messy, people will fall off.
Fix that before posting.

Start with outcomes you
can measure in real life



Accessibility isn’t a polish - it’s part of the plan. Keep
language plain, add alt text to images, captions to
videos, hashtags in CamelCase, and use photos that
are real and dignified. If translation or interpreting
would remove barriers, plan it upfront.

Know who you’re talking to
Every charity has multiple audiences. You don’t
need full personas the size of novels - snapshots
are enough to guide tone and content:

Who they are: “Parents of under-5s in
Renfrewshire”; “CSR managers in Glasgow.”
What they need: timetables, reassurance,
proof, clarity.
Likely barriers: time, transport, digital
confidence, stigma, trust.
Where they are online: Facebook Groups,
Instagram Reels, WhatsApp, LinkedIn.
Tone that works: friendly and practical; short
video; step-by-step carousel.

Spend 20 minutes with frontline staff and ask: “What
questions do people ask again and again?” You’ll leave
with three usable post ideas - no brainstorm required.  
If you’re short on time, AI tools can also help cluster
questions or summarise patterns from surveys,
feedback, or transcripts, but always sense-check with
real staff and service users to keep it grounded in
reality.

Choose fewer channels, use
them better

Being everywhere spreads you thin. Instead,
choose the channels that best connect audience
→ outcome → content. 

For some, that might mean focusing on one priority
channel done really well, supported by one or two
secondary channels for specific audiences or
purposes.

Checklist - Channel decision
grid

Is our audience really here?
Does this channel directly serve a key
outcome?
Do we have time to reply and moderate here?

Facebook: 44m UK users, still strongest for local
communities.

Instagram: 35m UK users, with fastest growth
among 25–44.

TikTok: 23m UK users, dominant with 16–24s,
growing in older groups.

YouTube: 56m UK users monthly; Shorts now
rival TikTok.

LinkedIn: 35m UK users, often overlooked but
critical for funders, partners, trustees.

WhatsApp: 40m UK users, with Channels
opening new broadcast possibilities.

UK Stat Snapshot 
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Rotate them. A pillar that doesn’t serve outcomes this quarter?
Park it.

Pick content pillars so
you never run dry

Pillars are your repeatable themes. They stop you scrambling for ideas and keep
the feed balanced. For most charities, repeatable content will include :

Help & How-to - practical steps, “what to expect” posts.
Impact & Proof - what changed because of your work.
People & Partners - volunteers, staff, lived experience (with consent).
Join In - events, donations, applications.
Values & Voice - myth-busting, thought leadership, solidarity.
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Be realistic about rhythm
and roles

Social shouldn’t eat every hour. A realistic week for a small team looks like:
2–3 posts on your main channel.
1 post on a secondary channel.
A couple of stories, reels, or shorts when helpful.

Consistency beats heroic bursts. Protect 60–90 minutes a week for social and
treat it as a habit, not an afterthought - because regular presence builds trust,
while sporadic activity makes you invisible.

Think in hats, not job titles:
Planner (sets outcomes and pillars)
Creator (drafts copy and assets)
Publisher (schedules and checks links)
Responder (answers comments and DMs)
Recorder (notes results and learning)

One person may wear them all - just name the hats so the work is visible
and easier to share.



Consent, dignity, and
safeguarding

Human stories work - but only when shared
with care. Always:

Ask for informed, specific, time-limited
consent.
Offer choices (named vs. anonymous; text
vs. photo vs. video).
Explain where content will appear and for
how long.
Log consent in one place.
Respect people’s right to change their
mind.

If in doubt, don’t post. Composites or
staff reflections are safer than risking
dignity.
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Charity Case Study -
Ready in Practice

Food Train (Scotland) faced a volunteer shortage in early 2024.
Instead of blasting generic recruitment posts, they narrowed their
focus: one outcome (“Recruit 100 new volunteers in 12 weeks”), one
channel (Facebook), and one content pillar (human stories of current
volunteers). By pairing short Reels filmed on phones with a simple
“Join Us” landing page, they filled 80% of their target within 10 weeks.
Their learning? Focus beats scatter. Awareness only mattered
when it led to actual sign-ups.

Food Train Scotland

Minimum Legal Ages for Social Media Platforms

TikTok – 13+ (some features restricted until 16+)
Instagram – 13+
Facebook – 13+
Snapchat – 13+
X (Twitter) – 13+
WhatsApp – 16+ in UK/EU (13+ in some other
regions)
YouTube – 13+ (or under 13 with YouTube Kids +
parental consent)
Pinterest – 13+
Discord – 13+ (17+ in some app stores due to
content rating)



Helpful
Resources 
CharityComms - Social media strategy templates

NCVO Know-How - Comms planning and policies

Meltwater UK 2025 Social Media Report

RNIB Accessibility Guides

SCVO Digital & Cyber Security resources

Digital Unstuck - practical starter prompts for content
and more
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https://www.charitycomms.org.uk/social-media-updates-and-resources
https://knowhow.ncvo.org.uk/
https://www.meltwater.com/en/state-of-social-media
https://www.rnib.org.uk/living-with-sight-loss/assistive-aids-and-technology/tv-audio-and-gaming/guide-to-accessible-social-media/
https://scvo.scot/support/digital
https://thirdsectorlab.co.uk/the-gathering-2025-resources/
https://thirdsectorlab.co.uk/the-gathering-2025-resources/
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Section 2. 
Set! 
(Govern well, post
with confidence)



1

Set!
Good governance doesn’t kill creativity - it
enables it. When your team knows the
boundaries, the approval paths, and the
safety nets, they post with confidence and
authenticity. Without guardrails, fear and risk-
aversion creep in, and posts get stuck in
endless drafts.
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1

A 20-page social media policy will sit on a shelf unread. A 2-page
guide will actually get used. Keep it tight and focus on:

Why you use social media.
Who it applies to (staff, volunteers, trustees, contractors).
Key principles (accuracy, accessibility, dignity, political neutrality).
Roles and responsibilities (planner, publisher, responder,
safeguarding lead).
House rules for followers (what you welcome, what you won’t
tolerate).
Escalation paths for safeguarding, complaints, or data breaches.

Publish house rules publicly so the community knows what’s
expected. Keep them plain and visible.
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We welcome respectful discussion. We will remove content that
includes hate speech, harassment, misinformation, spam, or personal
details. For urgent support, contact us at [inbox/phone]. In an
emergency, call 999.

House Rules (copy + adapt)

Why a short policy
makes everything easier



Pitfall: Overly long approval chains. Long sign-offs kill more
good ideas than bad ideas ever will. 

Name a backup for each. In small teams, one person may wear
multiple hats - but naming them makes the work visible.

Roles, responsibilities,
and approvals

Confusion about “who does what” is one of the biggest blockers in charity comms.
Be explicit:

Account Owner - manages logins and admin rights.
Publisher - schedules and posts content.
Responder - monitors comments/DMs, escalates when needed.
Safeguarding Lead - decides on child/vulnerable adult concerns.
Data/GDPR Lead - handles data breaches or removal requests.
Content Generators - staff and colleagues activly feed into content creation
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Keep it lean:
Day-to-day posts: 1 sign-off (or none once trained).
Sensitive/campaigning posts: 2 sign-offs max.
Crises: pre-agreed holding statements so you don’t freeze.



Consent, dignity, and
data
Human stories work best - but only when offered,
not taken. Follow three rules:

Informed: explain where, how, and how long
content will be used.
Specific: give people choices (named vs
anonymous, photo vs text).
Time-limited: consent expires; log it in one
place.

If someone withdraws consent, act quickly. If
in doubt, don’t post.
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Moderation that protects
people and your mission
Your social channels are community spaces. Think of yourself as host, not
gatekeeper. Apply house rules consistently - and make sure they reflect your
organisation’s values, so your online spaces feel aligned with who you are offline

Frustrated service user? Acknowledge and offer to move to a private channel.
Misinformation? Correct calmly with a reliable source.
Harassment/hate speech? Remove and block.
Safeguarding concern? Escalate immediately.
Journalist questions? Thank and hand to your press lead.

Security and cyber
resilience
Most breaches come from simple errors: weak passwords, old admins, no two-
factor authentication. Protect yourself with:

Password manager for staff.
Two-factor authentication on every account.
Remove leavers’ access the same day.
Keep a channel register with owners, purpose, and admin list.

If you use AI tools to edit or repurpose stories, be
transparent about it and keep human oversight.
Trustees should understand where AI is used in
your comms workflow, and boards should record
decisions in line with wider digital governance.
Check the Scottish AI Playbook for best practice. 

https://www.scottishaiplaybook.com/


Campaigning and
political activity

Charities can campaign on issues linked to their purpose - but must stay
independent of political parties and candidates. This matters most in an election
season, when scrutiny is particularly high.

Keep comms factual and respectful.
During elections, have a short internal approval route for sensitive posts.
Record decisions and rationale.

See OSCR campaign guidance here.
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Crisis and escalation
You don’t need a 30-page crisis manual. You do need a one-page checklist:

Who to call first (safeguarding, CEO, data, press).
How to pause scheduled posts.
Draft holding statement: “We’re aware of X, we’re looking into it, and will
update by Y.”
How to log what happened.
Internal comms: send a quick update so staff and volunteers know the
agreed line and don’t feel left in the dark.
Care for people affected: if service users, victims, or staff are involved,
prioritise their safety and wellbeing before posting publicly.
Run a quick “fire drill” once a quarter so the team knows it under pressure.

It’s likely that your leadership team and your organisation’s risk register will already
have a wider crisis plan in place - social media should play a key part of this. Use
the one-pager to capture the essentials (contacts, steps, draft statements) and
make sure it links back to your organisation’s broader plan so everything joins up.

https://www.oscr.org.uk/news/updated-guidance-for-scottish-charities-on-campaigning-about-political-issues/
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Where social can go
wrong

Awareness obsession: chasing likes and impressions with no link to action.
Over-scheduling: posts go out during a crisis because no one paused the
queue.
Neglecting moderation: harmful comments left unchecked.
Tokenism: posting on Pride, Black History Month (BHM), or International
Women’s Day (IWD) with no substance behind it.
Burnout: one staff member expected to be “always on.”

Acknowledging pitfalls makes you safer.

Shift Your Culture
Long approval chains kill more good posts than bad ideas ever will.
The Charity Change Collective’s Toolkit for Transformation shows
how to build trust, shorten sign-offs, and empower teams to act faster.

It’s packed with behaviours and examples you can adapt for your own
organisation.

Read the Toolkit for Transformation

Charity Case Study -
Governance in Action
Mind (UK) publishes clear house rules on all its social platforms, outlining what is
and isn’t acceptable, and how people can access support if they’re in crisis. They
also share their moderation approach openly, which builds trust with audiences
and reduces accusations of censorship. The result? A safer, more supportive
space for service users and campaigners alike.

https://www.charitychangecollective.uk/collective-thoughts/toolkit-for-transformation-have-your-say?utm_source=chatgpt.com


Helpful
Resources 
CharityComms - Social media policy templates

NCVO Know-How - comms policies and planning

SCVO Digital & Cyber Security resources

OSCR - Campaigning & political activity guidance

SCVO - What charities can or can’t do in run up to an
election
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https://www.charitycomms.org.uk/article-type/templates
https://knowhow.ncvo.org.uk/
https://scvo.scot/support/digital
https://www.oscr.org.uk/news/updated-guidance-for-scottish-charities-on-campaigning-about-political-issues/
https://scvo.scot/policy/elections
https://scvo.scot/policy/elections


Section 3. 
Go! 
(Create, publish, and
build community)
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Go!
This is the fun bit - but also the place where
most charities get stuck. With the right prep
in place, you can focus on creating content
that’s useful, human, and easy to act on.
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The best question before posting is: “Who is this for, what do they need today, and what
action do we want them to take?” If you can’t answer that in one sentence, the post isn’t
ready.

People don’t follow charities for filler. They follow for answers, help, hope, or a clear
way to get involved.

23

Stories work because they make causes relatable. But stories
aren’t just assets to harvest. They’re gifts of trust.

Keep stories simple: person → challenge → support →
difference made → invitation to others.
Always gain informed, specific, time-limited consent.
Offer options (named/anonymous; text/photo/video).
Respect people’s dignity - no trauma porn, no pity framing.

Hope-based comms
Not every serious issue needs heavy tone.
Hope, solidarity, and shared wins can be
just as powerful. A positive frame can make
action feel possible, not overwhelming.

Read the strategy

Lead with usefulness

Tell human stories (safely)

Choose formats that
make action easy

Short-form video (reels, TikTok, shorts): 20–60 seconds, captions
baked in, one clear action.
Carousels: step-by-step guides, myth-busting, countdowns. First
slide = promise, last slide = call-to-action.
Stories/ephemeral: event reminders, polls, Q&A.
Graphics: only when they clarify - not just decorate.
Longer-form (YouTube, LinkedIn): explainers, reports, thought
leadership.

Checklist - Is this
format fit for
purpose?

Does it suit the audience’s habit on this channel?
Is the call-to-action clear?
Is it accessible (captions/alt text/high contrast)?

https://www.hope-based.com/about
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Captions that convert
(without sounding
salesy)

Write like you talk. Lead with benefit. Ask for one action.

Patterns to try:

Help → How → Do: “Free warm spaces near you this week. Five locations,
10–4. Tap to book.”
Problem → Path → Proof: “Worried about rent? Book a 20-minute call. Last
month, we helped 41 families reduce payments.”

Pitfall: Heroic bursts followed by silence.
Momentum comes from rhythm, not
volume.

Editorial rhythm you can
keep

A good social media plan isn’t about doing more - it’s
about finding a rhythm you can actually stick to. Small,
regular habits build momentum and trust far more than
one-off bursts of activity.

10 minutes weekly → review last week, note
keep/stop/start.
30 minutes weekly → draft and schedule 2–3 posts.
15–30 minutes weekly → reply to comments/DMs, tidy
links.

Reuse winners until
they’re done

If a post lands, adapt it:
Carousel → short Reel → LinkedIn post → local FB Group version →
WhatsApp reminder.
Same message, adapted for context. That’s alignment.
AI tools can speed this up by drafting variations for different channels, but
always review so the tone stays true to your organisation’s voice.
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AI in Practice: Repurpose,
Don’t Replace

How AI can help charities right now:
Summarise: turn a 2-page blog into three caption options.
Reframe: adjust tone for Instagram vs LinkedIn.
Repurpose: lift key points from a transcript for a carousel.
Translate: produce draft versions in other languages (always review with a
human).
Draft: generate caption variations, then edit to keep your voice.

Prompting tips that work:
Be specific: “Write a LinkedIn caption for funders about X in a professional but
hopeful tone.”
Give context: paste your blog, transcript, or old post so it has source material.
Ask for options: request three variations, not one, so you can choose.
Edit ruthlessly: keep what’s useful, cut the fluff, and add your own voice.

Checklist - AI Golden Rules
Use it for first drafts, not final posts.
Always review for accuracy, accessibility, and
dignity.
Be transparent internally about when and
how it’s used.
Link to the Scottish AI Alliance Playbook for
governance.
Explore CAST’s Library of AI Experiments for
real charity use cases.

CAST’s Library of AI Experiments shows
real charities testing AI tools for
captioning, translation, and drafting.

https://www.wearecast.org.uk/our-work/free-digital-resources/library-of-experiments/
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Where social can go
wrong (content edition)

Over-designed graphics with no human element.
Awareness posts with no call-to-action.
Chasing trends that don’t fit your cause.
Posts signed off two weeks late - published after the moment passes.

Charity Case Study - 
Social Done Simply

Bloody Good Period built much of its growth by pairing sharp
Instagram carousels with simple calls-to-action (“Here’s how to
donate products this week”). Their posts blend information, activism,
and humour without slipping into tokenism. They use their feed to
campaign, their stories to mobilise, and their captions to link directly to
tangible action. The result? A community that not only shares but also
acts.

Bloody Good Period

Paid and organic must
work together 

Organic content still matters for building relationships, authenticity and trust. But in 2025,
unsponsored posts often reach just 1–4% of followers on major platforms. 

 For charities, that means:
Test content organically first to find what resonates.
Then consider paid promotion of posts that perform well or campaigns with specific goals.
Treat paid as essential, not optional if you want consistent reach and impact.
Keep your targeting tight (postcode, age, interest) and stick to one objective, one creative, one
landing page.
If the landing page doesn’t convert, fix it before spending more.



Helpful
Resources 
Hope-Based Comms Toolkit 

Charity Digital - 101 TikTok 

Google Ad Grants 

CharityComms - How to write captions that convert 

Meltwater UK 2025 Social Media Report 

Scottish AI Playbook 

CAST AI Experiments
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https://www.hope-based.com/
https://www.hope-based.com/
https://charitydigital.org.uk/topics/a-charity-guide-to-tiktok-8245
https://charitydigital.org.uk/topics/a-charity-guide-to-tiktok-8245
https://www.google.com/grants/
https://www.charitycomms.org.uk/how-to-caption-your-social-media-content-and-why-you-should
https://www.charitycomms.org.uk/how-to-caption-your-social-media-content-and-why-you-should
https://www.meltwater.com/en/state-of-social-media
https://www.scottishaiplaybook.com/
https://www.scottishaiplaybook.com/
https://www.wearecast.org.uk/our-work/free-digital-resources/library-of-experiments/
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Section 4. 
Measure! 
(Learn, improve,
repeat)



Measure!
Measurement isn’t about charts for the sake
of it. It’s about learning what helps your
mission and doing more of that. Too many
charities still confuse awareness with impact.
A post with 5,000 impressions but zero sign-
ups is noise. The question isn’t “how many
people saw this?” but “did this change
anything in the real world?”
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Add UTM tags to every link so you know
which post drove traffic.
Test your landing pages on mobile - are they
quick and clear?
Screenshot highlights from platform analytics
weekly.
Set up 2–3 GA4 goals (donations, forms,
downloads).
Ask “How did you hear about us?” on sign-up
forms.
Use AI tools to summarise performance data
into plain-language takeaways — but always
interpret results with human judgement.

Outcomes first, metrics second
Likes and views are vanity metrics unless they connect to action.
The true measures for your organisation might look like:
Bookings filled
Applications received
Donations made
Volunteer sign-ups
Policy actions taken (emails sent, petitions signed)

 Awareness is a starting point, not a success metric.

Checklist -Minimal tracking
set-up

Keep tracking light but consistent
You don’t need a dashboard army. You need a simple habit.
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Review in a rhythm you
can keep

Weekly glance: 5 minutes - what post stood out? Screenshot it.
Monthly review: 30 minutes - check results against outcomes. Note
keep/stop/start.
Quarterly reflection: adjust outcomes, revisit content pillars, run a “crisis fire
drill.”

Share learning across the
team
Social media isn’t just a comms job. Bring the whole team into the loop.

5-minute slot in staff meeting: “One post that worked, one learning, one
experiment next month.”
Trustees: one-page summary (outcome, result, screenshot, next step).
Funders: focus on real-world impact - not reach alone.

Sharing results builds trust internally as well as externally.

Pitfall: drowning in data. If you’re tracking 20 numbers but
acting on none, simplify.
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Charity Case Study - 
Transparency

Shelter UK uses its blog and socials not just to celebrate wins but
also to talk about the ongoing scale of housing need, even when
progress is slow. That transparency positions them as a trusted,
honest voice in a crowded debate.

Shelter UK

Transparency builds
credibility
Audiences expect openness. Don’t just share polished success stories - share the
process, too. Post about what didn’t work, what you learned, and what you’ll try
differently. It shows honesty and builds trust.

Transparency builds
credibility
Most charities don’t struggle with measuring - they struggle with measuring the
right things. Common mistakes turn data into noise instead of insight, and can
leave boards celebrating reach while missing what really matters: outcomes and
learning.

Measuring everything → acting on nothing.
Reporting reach to trustees without outcomes.
Failing to test landing pages - good posts die on bad forms.
Treating negative feedback as failure rather than learning.

https://england.shelter.org.uk/media
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Want to know how other charities are already experimenting with AI? CAST
has built a Library of AI Experiments - real nonprofit examples of AI used for
captions, translations, content drafting, summarisation and more.

It’s a practical way to spark ideas before you launch your own trial.

See AI in Action

Charity Case Study - 
Light but effective
measurement

Breast Cancer Now shifted from reporting impressions to focusing
on actions. For their “Wear It Pink” campaign, they tracked one thing:
sign-ups. By tagging every link and simplifying the sign-up page, they
could clearly see which posts worked. The winning content? Short
videos from staff and supporters explaining why they take part. Sign-
ups rose 15% year on year.

Breast Cancer Now 

https://www.wearecast.org.uk/our-work/free-digital-resources/library-of-experiments/?utm_source=chatgpt.com
https://breastcancernow.org/wear-it-pink
https://breastcancernow.org/wear-it-pink


Helpful
Resources 
Google Analytics 4 - Conversions and goals

Charity Digital - How to measure digital impact

NCVO - Impact and evaluation guidance

Shelter UK blog (example of transparent comms)

Breast Cancer Now - Wear It Pink campaign
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https://support.google.com/google-ads/answer/10995103?hl=en-GB&sjid=3615162262892631310-EU
https://charitydigital.org.uk/topics/how-to-measure-digital-impact-9334
https://www.ncvo.org.uk/help-and-guidance/strategy-and-impact/impact-evaluation/
https://england.shelter.org.uk/media
https://wearitpink.org/
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Section 5. 
Resources & Quick
Reference
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Resources &
Reference
Good systems save time. Instead of
reinventing the wheel for every campaign,
keep your core resources in one shared
folder. That way, when someone new joins
the team - staff, trustee, or volunteer - they
can pick up the essentials quickly and
confidently.
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Build your “/Social
Governance” folder

This should be the home for everything you need to run social media well. Keep it
in a shared, secure space (Google Drive, OneDrive, SharePoint, etc.) that’s easy to
update.

Checklist - What to include in
Social Governance

Social media policy (2 pages) - plain English, used daily.
Channel register - what accounts exist, why, and who manages them.
Consent log - names/IDs, dates, scope, expiry, restrictions.
Moderation crib sheet - one-page “if X, then Y.”
Crisis one-pager - who to call, how to pause posts, draft holding statement.
Accessibility cheatsheet - alt text, captions, colour/contrast.
Onboarding/leavers checklist - add/remove access, training, sign-offs.
Story capture form - with consent options people can understand.
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Quick Reference - Desk
Printable

A one-page poster you can stick above your desk, or share with
colleagues.

Before you post:
Who is it for?
What do they need today?
What action do we want?
Do audience → channel → content line up?
First line = benefit?
Webpage = mobile-friendly?

Make it human and accessible:
One message per post.
One clear action.
Plain English.
Alt text & captions every time.

Caption patterns:
Help → How → Do.
Problem → Path → Proof.

Reuse winners:
Carousel → Reel → LinkedIn post → FB Group version → WhatsApp reminder.

Moderation basics:
Acknowledge.
Move sensitive chats to safe private channels.
Apply house rules consistently.

Measurement rhythm:
Weekly glance.
Monthly outcomes check.
Quarterly keep/stop/start.
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Charity Case Study - 
 Resources Done Well

Crisis (UK homelessness charity) has a public-facing media
centre that doubles as a comms resource hub. It includes house
rules, brand guidelines, downloadable assets, and key messages. By
making resources open, they reduce internal bottlenecks, keep
messaging consistent, and empower staff and partners to share
confidently.

Crisis (UK homelessness charity)

Bringing it all together
You don’t need a bigger megaphone. You need clarity, care, and consistency.

Pick a few outcomes that matter. Go where your audiences already are. Share
human stories with dignity. Make the next step obvious. Keep content accessible.
Measure lightly and adjust as you learn. And above all - back your comms people
with trust, resources, and governance.

If you’re starting today, keep it simple: one outcome for four weeks, one main
channel, two helpful posts a week, one short landing page, and a weekly review.
That’s enough to build momentum. Add from there.

https://www.crisis.org.uk/about-us/crisis-media-centre/


Additional
Resources 
CharityComms - Social media policy and strategy
guides

NCVO Know-How - comms and impact templates

Charity Comms - Social Media Updates

SCVO - Digital & cyber security resources

RNIB Accessibility guidance

OSCR - Campaigning and political activity guidance

Training & Skills 

Third Sector Lab - free digital, data and design training 

HubSpot 
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https://www.charitycomms.org.uk/social-media-policy-template
https://www.charitycomms.org.uk/social-media-policy-template
https://knowhow.ncvo.org.uk/
https://www.charitycomms.org.uk/social-media-updates-and-resources
https://scvo.scot/support/digital/cyber-resilience
https://scvo.scot/support/digital/cyber-resilience
https://www.rnib.org.uk/living-with-sight-loss/independent-living/accessible-nhs-and-social-care-information/accessible-health-and-social-care-resources/
https://www.oscr.org.uk/news/updated-guidance-for-scottish-charities-on-campaigning-about-political-issues/
https://thirdsectorlab.co.uk/training/
https://thirdsectorlab.co.uk/training/
https://academy.hubspot.com/courses/social-media?utm_id=741389584456&utm_term=academy_%2Bfree%20%2Bsocial%20%2Bmedia%20%2Bcertification_EN&utm_campaign=Academy_Portals_EN_EMEA_UKI_SocialMediaCert-NonBrand_e_c_campaignid12619891409_agid122882984831_google&utm_source=google&utm_medium=paid&utm_content=_&hsa_acc=9694350438&hsa_cam=12619891409&hsa_grp=122882984831&hsa_ad=741389584456&hsa_src=g&hsa_tgt=kwd-2007925296205&hsa_kw=%2Bfree%20%2Bsocial%20%2Bmedia%20%2Bcertification&hsa_mt=e&hsa_net=adwords&hsa_ver=3&cq_cmp=12619891409&cq_plac=&cq_net=g&gad_source=1&gad_campaignid=12619891409&gbraid=0AAAAADP5F9wRK--p1H52-ycSqyX5Yrtbc&gclid=Cj0KCQjwvJHIBhCgARIsAEQnWlC-pCrmh_bGlxYbwv1iac4HAJ9fC5rrX8axgm16rhi9b0qD7_wGq0UaAleoEALw_wcB
https://academy.hubspot.com/courses/social-media?utm_id=741389584456&utm_term=academy_%2Bfree%20%2Bsocial%20%2Bmedia%20%2Bcertification_EN&utm_campaign=Academy_Portals_EN_EMEA_UKI_SocialMediaCert-NonBrand_e_c_campaignid12619891409_agid122882984831_google&utm_source=google&utm_medium=paid&utm_content=_&hsa_acc=9694350438&hsa_cam=12619891409&hsa_grp=122882984831&hsa_ad=741389584456&hsa_src=g&hsa_tgt=kwd-2007925296205&hsa_kw=%2Bfree%20%2Bsocial%20%2Bmedia%20%2Bcertification&hsa_mt=e&hsa_net=adwords&hsa_ver=3&cq_cmp=12619891409&cq_plac=&cq_net=g&gad_source=1&gad_campaignid=12619891409&gbraid=0AAAAADP5F9wRK--p1H52-ycSqyX5Yrtbc&gclid=Cj0KCQjwvJHIBhCgARIsAEQnWlC-pCrmh_bGlxYbwv1iac4HAJ9fC5rrX8axgm16rhi9b0qD7_wGq0UaAleoEALw_wcB
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Templates &
Worksheets
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How to Use This
Bundle
These templates are designed to save time
and reduce friction. They give you simple
structures for planning, governance, and day-
to-day social media practice.

They’re not meant to be prescriptive. Every
charity is different - your audiences,
outcomes, and capacity won’t look the same
as another organisation’s. Think of these as
starter tools: copy and paste them into a
Google Doc, adapt them into a shared
spreadsheet, drop them into Notion or Trello,
or print them out for team meetings. The
point is to make them yours, not to follow
them word-for-word.

The most effective use of these templates is
collective: share them with colleagues,
trustees, and volunteers so digital stops being
“one person’s job” and becomes part of how
the whole organisation communicates and
learns.
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Disclaimer
This guide - and the templates included - has
been created by OSCR and Third Sector Lab
to provide practical help for charities
navigating social media in 2026.

It is not legal advice. Every charity is
responsible for making its own decisions
about how it communicates and operates
online. You should always:

Check your use of these tools against
your charity’s policies, safeguarding
procedures, and legal obligations.
Seek independent legal, data protection,
or safeguarding advice where necessary.
Remember that your trustees hold
ultimate responsibility for ensuring your
charity complies with the law and acts in
line with its purpose.

Use this guide as a foundation - but own
your choices. The best governance and the
best content are the ones that fit your
mission, your audiences, and your capacity.



Outcome
statement

Timeframe Action
required

Landing
page link

Success
measure

Owner

Example:
“Recruit 40

volunteers by
15 Dec”

8 weeks

4 social
posts, 

2 FB group
shares

volunteers.or
g/apply

# of
applications

received
Alex
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1. Outcome Planning
Worksheet

(From Section 1: Ready!)



Audience
group

Needs Barriers Channels
Tone &
format

Parents of
under-5s

(Renfrewshire)

Timetables,
reassurance

Transport,
childcare, digital

confidence

FB Groups,
WhatsApp

Friendly, simple
carousel
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2. Audience Snapshot
Worksheet

(From Section 1: Ready!)



Channel
Audience

here?
Serves

outcome?
Capacity to
moderate?

Decision

Facebook ✅ ✅ ✅ Keep

TikTok ❌ ❌ - Park

LinkedIn ✅ ✅ ✅ Prioritise
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3. Channel Decision
Grid

(From Section 1: Ready!)



Pillar Purpose Example formats Call to action

Help & How-to
Answer recurring

questions
Reels, carousels “Book now”

Impact & Proof
Show what

changed
Short video “Donate”

People & Partners
Highlight

volunteers/staff
Stories, photos “Join us”

Join In Mobilise action Event posts “Sign up”

Values & Voice
Myth-busting,

thought leadership
Threads, blogs “Share”
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4. Content Pillars
Worksheet

(From Section 1: Ready!)



Hat Responsibilities Named person Backup

Planner
Sets outcomes &

pillars
Sam Trustee rep

Creator
Drafts copy, edits

video
Alex Volunteer

Publisher
Schedules, checks

links
Alex Sam

Responder
Monitors

comments/DMs
Sam CEO

Recorder
Notes results,

shares learning
Alex Admin
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5. Role-Hats
Worksheet

(From Section 1: Ready!)



Name/ID Date
Scope
(where
used)

Expiry
date

Restrictio
ns

Removal
date

J.S. 10/01/2026
Website +

socials
10/01/2027

Anonymou
s only

-
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6. Consent Log
Template

(From Section 1: Ready! & Section 2: Set!)



50

8. Crisis One-Pager

Step 1: Pause all scheduled posts.
Step 2: Notify: Safeguarding lead, CEO, Data lead, Press contact.
Step 3: Holding statement: “We’re aware of [situation]. We’re looking into it and will update by [time].”
Step 4: Log actions taken.

7. Moderation Crib Sheet

If you see…

Frustrated service user → Acknowledge, move private.
Misinformation → Correct calmly with reliable source.
Harassment/hate speech → Remove, block, log.
Safeguarding concern → Escalate to Safeguarding Lead.
Journalist enquiry → Hand to press contact.

(From Section 2: Set!)

(From Section 2: Set!)

9. Accessibility Cheatsheet

Plain English
Alt text for every image
Captions/subtitles for every video
CamelCase hashtags
High-contrast colours
Avoid flashing/fast cuts

(From Section 1: Ready! & Section 2: Set!)
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11. Story Capture Form

Person’s name (or anon ID):
 Story (in their words):
 Consent (tick):

10. Onboarding/Leavers
Checklist

Onboarding: add to password manager, grant access, share policies, assign hats.
Leavers: remove access same day, update channel register, transfer hats.

(From Section 2: Set!)

(From Section 1: Ready! & Section 3: Go!)

12. Caption Writing
Worksheet

Post idea: ____________________
 Pattern: Help → How → Do OR Problem → Path → Proof
 First line (benefit): __________
 Call-to-action: ______________
 Hashtags (max 5): ___________
 Accessibility check: Alt text? Captions? Plain English?

(From Section 3: Go!)

Person’s name (or anon ID):Name / anonymous
Photo / video / text only
Where used (website, socials, print)
Expiry date

Signature/verbal consent logged: _______
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13. Quick Reference Poster

Before you post: Who’s it for? What’s the need? What action?

Golden rules: Plain English. One clear action. Alt text & captions.

Caption patterns: 
Help → How → Do.
Problem → Path → Proof.

Moderation: Acknowledge → Move private → Apply rules.

Measurement: Weekly glance → Monthly check → Quarterly review.

(From Section 5: Resources)




